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1 Introduction & Benefits

1.1 Welcome

Welcome to Infoplex TASflex™, the real-time integration tool for TASBooks, FirstBooks and the TAS
Books 1, TAS Books 2 and TAS Books 3 ranges of accounting products.

TASflex enables smooth integration between TAS and your other business software, whether that is
simply Excel or Outlook, or an advanced CRM or vehicle booking and hire system. The link lets you
have a two-way flow of data which is virtually invisible to the user and also “real-time”, i.e. both
systems are kept up to date as the user works. Yet, from a security point of view, access to TAS is
tightly controlled.

1.1.1 Note for Developers

TASflex is the end-user runtime integration product. As a developer, you need TASLink™ SDK
(Software Development Kit), which gives you the tools you need to develop a controlled integration
with TAS software quickly, easily and cost effectively. Both TASflex and TASLink are compatible with
the latest versions of the TAS range of accounting products, as well as supporting earlier products.
TASLink provides an object model, based on the Component Object Model (“COM”) specification, for
reading and writing information from and to the TAS range of accounting software. With COM it is
possible to use TASLink in Microsoft Visual Basic, Microsoft Visual C++, in applications such as Word
and Excel that support Visual Basic for Applications, and in scripting environments such as JavaScript
and VBScript - which widens the scope of its use to Internet-based technologies like Active Server
Pages.

1.2 Key Benefits
1.21 For End-Users

TAS is automatically updated without you having to manually rekey into TAS details of Customers or
Suppliers, Sales, Purchase, Cash Book and Nominal Journals, as well as Payment Allocations and
Budgets; the same applies to Products, Stock transactions, Sales Orders and Purchase Orders.
Less duplication of manual effort means that your business saves time and money, as well as helping
eliminate errors. By removing bottlenecks your users’ efficiency is maximised.

Similarly, up to date information from TAS is available on demand to your other business software,
whether to provide reports, enquiries or warnings. Your users no longer have to spend time logging
in to TAS and running an enquiry because the information they need is already at their fingertips.

For example, imagine that you are a garage and bodyshop business and you have an industry-
specific program to handle your estimating, links to insurance companies, parts, labour, insurance
excesses and invoicing. If this program uses TASflex, when you add new customers (or change the
details of existing ones), TAS is automatically updated. Similarly, if your Financial Controller had put
a customer on credit stop in TAS, your program could automatically alert you and give you the ability
to drill down to the customer’s TAS transaction history. Also, when a sales invoice (or credit note) is
printed and “posted” by your bodyshop program it could automatically post the journal to the TAS
Sales and Nominal Ledgers - same with purchase invoices.

In another case, you may need to update a spreadsheet with the latest figures from the TAS Nominal
Ledger or Debtors in order to produce summarised Management or Financial Control figures. It can
can be quite a hassle, and very time consuming, to go through the routine of exporting from TAS to
CSYV file, maybe reorganising the rows and columns, then copying and pasting selections to your
master spreadsheet. Imagine if you could achieve that with a few mouse clicks — just open your
spreadsheet, click a button, select the periods and whether to include “BBFs”.
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TASflex’s key benefits for end-users can be summarised as follows:

Benefit
Reduce expensive manual processing costs
Eliminate re-keying errors
Streamline time-consuming processes
Reduce delays and bottlenecks
Handle Customer and Supplier records and Notes
Process and retrieve over 40 different types of Nominal, Sales &
Purchase Ledger and Cash Book Journal Transactions, plus Budgets
Handle Product Stock & Service records
Process and retrieve Stock Transactions, including full Sales Invoices
Process, retrieve and Update Sales Orders
0 | Tighter Financial Control

ONnhrWN-

= © 0 N

1.2.2 Developer Benefits

With over 85,000 TAS customers in the UK and Ireland, TAS is one of the top three systems for
SMEs and the number of businesses relying on TAS is growing fast — many may be among your own
customers. In this increasingly connected world, being a TAS Developer enables you to do business
with the thousands of other companies who rely on TAS.

TASLink SDK is designed for use by professional 3rd party/in-house developers of business software
with a good understanding of object-orientated programming. It lets you read from and write to the
rich TAS database in a way that doesn't require detailed knowledge of the underlying business rules
(unlike traditional ODBC/SQL methods). TASLink hides those rules, yet enforces them, thus helping
to ensure that the integrity of the TAS database is never compromised.

1.3 Licensing
There is a dual licensing policy as follows:

1. alow-cost TASLink SDK licence for development purposes only, and
2. aruntime TASflex licence for internal business use at each end-user installation.

TASflex and TASLink each have the same two main product purchase options depending on whether
or not you wish to handle Stock and Order Processing in addition to the Financial Ledgers:

Set Basis Description
1 | Finance Financial Ledgers All the objects necessary to read and write the
only main Nominal Ledger journals and Budgets,

the Customer and Supplier records, plus
Sales Ledger journals, Purchase Ledger
journals and Cash Book journals

2 | Plus Financial Ledgers Covers Stock/Products & Services, Sales
and Stock & Order | Orders, Purchase Orders and Marketing
Processing

There are further options covering the number of users and the number of TAS company datasets to
be accessed.
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1.4 Business Examples

Many businesses use spreadsheets to handle a lot of their computing work. But much of the data
needs to be transferred between (to/from) the spreadsheets and TAS. A TASflex solution, developed
with TASLink SDK, solves this problem by automating the data transfer with one or two mouse clicks.

In other cases, businesses have their own "front-end" software which is specially designed to handle
their particular business activity. Typically these systems go up to the stage of producing Sales
invoices, or even recording Purchases and Payments. However, to achieve proper financial control
and integration, as well as to produce timely Financial Statements, Debtors & Creditors Lists,
Customer Statements and Bank Reconciliations, all these transactions have to be re-entered to TAS
along with, in the case of Sales and Purchases, keeping the customers and suppliers “in sync”
between the systems. Again, a TASflex solution, developed with TASLink SDK, provides the answer.

The table below lists some common examples and shows how these relate to the two parts of
TASflex (and TASLink).

Example
Type Software Description Finance Plus
Office: Get latest P&L or Trial
spreadsheet, Excel Balance figures for v v
word Management Accounts
processing Word Prepare Customer Statements v v
I\E/Ianggement & MXContact display their details and Y v
mail .
history.
ACT! As previous, plus link products
CRM Maximiser and pricing, create Sales v
Goldmine Orders, view Order history
Bespoke Post sales invoice journals to
Booking/Hire | TAS; get up-to-date Credit v
Order Recruitment Control |nformat|o_n anq
. customer transaction history
Processing -
Contract As previous, p!us _post
) . Purchase invoice journals and v
Engineering . o
display Supplier history/terms
Process Customer website v
Orders and Payments
As previous, except post full
eCommerce Website Sales Invoices to TAS Stock
(bespoke) System and auto-generate v
Sales Invoice Journals;
process Stock Adjustments
and Assembly Builds

Version 2.3, 01 Nov 2010
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1.5 Contents

TASflex comprises the items listed in the table below. For convenience TASLink items are listed too:

Item Description TASLink TASflex

1 | A User Reference Manual v v
2 | SIM (System Integration Manager) v v
3 ‘TASLink’ Dynamic Link Library ActiveX component v v
4 | TASLink Control Centre SIM module v

5 TASflex Control Centre SIM module v
6 glel\l/la)ted dependent components (installed by/with v v
7 Sample spreadsheet containing VBA examples v

Infoplex SIM (System Integration Manager), manages security, setup, user configuration, versioning
and licensing for all Infoplex software modules.

Version 2.3, 01 Nov 2010
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1.6 System Organisation & Structure

1.6.1 Organisation

To enable correct linking between the Developer’s software Application, the Dynamic Link Library
ActiveX component (TASLink.dll) and TAS Books, TASLink uses Infoplex’s SIM technology. The
diagram below illustrates how this is organised.

Tables and Files used by the system are detailed in Files & Tables Used in the Appendices.

General Organisation

Infoplex
TASLink

\

Infoplex SIM
(System Integration
Manager)

/

TAS
Books
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Acronyms & Jargon

Acrony n Meaning Notes
AlC Account e.g. A/C Number
ASCII American Standard Code Allows digital devices to communicate with each other and to
for Information Interchange | process, store, and communicate character-oriented information
BoM Bill of Materials a key part of an MRP system
CB Cash Book Also a Ledger
CoA Chart of Accounts
CRM Customer Relationship Software system for managing customer relationships, inc
Management Contact Management)
CSsVv Comma Separated Variable | A standard type of ASCII text file used for transferring data
between systes
Dr/Cr Debit/Credit In bookkeeping Debit values are always positive, whilst Credit
values are negative; hence a balanced double-entry must
consist of at least 2 items
EDI Electronic Data Interchange | In business this most often refers to the transfer of data
between trading partners, e.g. customers and suppliers
ERP Enterprise Resource Software system encompassing almost all aspects of business,
Planning inc CRM and accounts
FIFO First-In First-Out A method of Stock Valuation based on the assumption that
when stock is sold, it is items that first came in that are sold.
MRP Materials Regirements Production planning and stock/inventory control system used to
Planning manage manufacturing processes
MRP II Manufacturing Resource Method for the effective planning of all resources of a
Planning manufacturing company
NL Nominal Ledger Also called General Ledger
Open Item Incomplete/unpaid e.g. an unpaid invoice, i.e. one which has no payment(s) fully
transaction allocated against it
PL Purchase Ledger Also called Creditors Ledger, Suppliers Ledger or Accounts
Payable
PO Purchase Order
POP Purchase Order Processing
SL Sales Ledger Also called Debtors Ledger, Customers Ledger or Accounts
Receivable
SO Sales Order
SOP Sales Order Processing
ST Stock Ledger Also called Inventory or Products
VAT Value Added Tax A Sales Tax
WiP Work in Progress A value assigned to part-completed work
wo Works Order Used in BoM (Bill of Materials)
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2

Quick Start

This section explains how to quickly install and set up your TASflex system.

Important — Network Paths

To help avoid confusion in Network installations it is strongly recommended that
UNC paths are used instead of mapped drive letters.

For example: \\OurServer\TB3Data\Data1 instead of T:\Data1.

In order to get going quickly with TASflex, the steps set out in the table below should be followed.

Step | Action Notes

1 Install Infoplex SIM (System Integration You can obtain the SIM Installer program from the
Manager) onto your computer using the SIM Infoplex website via TASLink Download page, which
Installer program. has full details of how to install SIM. Setup details are

in the SIM Manual (SIM_Manual.pdf).

2 Login into SIM as the ADMIN user User Name = ADMIN, password = ADMIN

3 Do the basic setup in SIM as described in steps | For full details see Appendix A — Installation, Setup &
4 to 7 below Launch in this manual

4 Install at least one TAS company, preferably a | use the Tools>Companies>Maintain/Add function -
test/demo company in the first instance details are in the SIM Manual (SIM_Manual.pdf) and

the Important — Network Paths note above

5 Install the TASflex Control Centre Module from | use the Tools>Modules> Add/Upgrade function (see
within SIM Installation in Appendix A)

6 Integrate the Module to at least one company, | use the Tools>Modules>Maintain/Add function (see
preferably the Test/Demo company initially Setup Integration & User Access rights to TAS

Company in Appendix A)

7 Add access rights for each valid user in SIM for | using the Tools>Users>Access Rights function
the Module(s)

8 In SIM’s Module Selection form double-click In the main SIM form’s Companies tab, simply double-
the module to Launch it at the selected click on your selected company and, in the Module
company Selection form double-click the module to Launch it at

the selected company (see Launching Modules in
Appendix A)

9 (Future) Important — If this is the first time that | (Future) Use the Company Options functions from the
TASLink has been used in this company, you Setup menu — see Company Options
must now configure the default values in order
that TASLink functions work correctly

10 Close the Module and then close SIM Full details of how to do these are described in the

Main Menu section below

11 You can now run your application using SIM installation will have registered the Dynamic Link
TASflex (and the TASLink library of functions) | Library ‘TASLink.dII' as well as other components

12 If you hav a multi-user TASflex licence, repeat | Important — the second and subsequent PC
the above steps for each PC on the network workstation installations should select the Network

Client option during the intial SIM setup and use the
same network folder as was created by the first PC
workstation installation

Version 2.3, 01 Nov 2010
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3 Versions, TAS Compatibility & Standards
3.1 Products and Versions

The product versions covered by this document are:

Infoplex Product Version
TASLink library

System Integration Manager (SIM)
TASLink Control Centre SIM Module

3.2 TAS Product Version Compatibility

The product(s) listed above are for use with TAS 32-bit Windows products as set out in the table
below. To check which Data Version your TAS product is: login to TAS, on the menu go to Help >
About, select the Product Information tab, left-click the ‘System’ item in the left-hand pane and you
can see the Data Version in the right-hand pane (last item).

Latest Data Version | Earliest Data Version

TAS Product supported by SIM supported by SIM
TASBooks (inc Stock module) 1.21 1.20

FirstBooks 1.21 1.20

TAS Bookkeeper n/a n/a

TAS Books Small Business Edition n/a n/a

TAS Business Controller n/a n/a

TAS Books Accounting Plus n/a n/a

TAS Books Accounting n/a n/a

Except where the context requires otherwise all TAS 32-bit Windows accounting systems are from
here on referred to simply as “TAS”.

Important — Some Limitations

TASLink covers the majority of day-to-day functions which are likely to be needed
for real-time automation and integration with other software applications.
However, there are some limitations which are described in section 3.4 below.

3.3 Standards

Unless stated otherwise, the system is written to conform broadly to the same general standards
utilised by TAS so that there is a common look and feel, whilst maintaining adequate security. These
include user access security via SIM and the use of function keys.
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3.4 Limitations

TASflex covers the majority of day-to-day functions which are likely to be needed for real-time
automation and integration with other software applications. However, there are some limitations
which are described in this section.

3.4.1 General TAS Functional Areas NOT supported
TASflex does not currently cover the following general TAS functionality:

e Projects

Purchase Order Processing beyond initial PO creation, e.g. edit PO, receive goods, receive
invoices

Cash with Order in Sales Order Processing

Fixed Asset Register

VAT reporting

TAS Setup maintenance

Payroll

3.4.2 Non-Standard VAT Accounting and CIS systems

TASflex provides limited support for certain types of transactions in systems set up to use non-
Standard VAT Accounting and CIS (Construction Industry Scheme) schemes.

1. VAT Cash Accounting (Money Received basis in Ireland) — where VAT inputs and outputs
are based on cash paid or received rather than on invoices/credit notes. The following
Financial Journal transaction types/methods are not supported:

Sales Ledger Receipt Allocation

Sales Ledger Credit Note/Journal Allocation

Purchase Ledger Payment Allocation

Purchase Ledger Credit Note/Journal Allocation

Cash Book Receipts

Cash Book Payments

Sales Order Processing Credit Note Allocation

@ oo

2. VAT Reverse Charge scheme (UK only) — for transactions involving certain types of
electronic goods supplied to/from other UK businesses. TASflex does not support these
particular transactions.

3. VAT Reverse Charge scheme (Ireland only) — applies to the construction industry, in cases
where Relevant Contracts Tax applies. TASflex does not support these particular
transactions.

4. Flat Rate VAT Scheme (UK only) — this is designed to help simplify VAT Return calculations
for small businesses. TASflex does not support two types of transactions involving Fixed
Assets where, if you claim back the VAT on the purchase of a capital asset, then when you
have finished with the asset and sell it, you must charge VAT at the full standard rate - not at
your flat rate percentage.

a. Sale of Fixed Assets
b. Purchase of Fixed Assets

5. CIS scheme (UK only) — TASflex does not support Purchase Ledger payments to suppliers
set up as sub-contractors under this scheme. It does allow the posting of Invoice and Credit
Note type transactions for these suppliers if the appropriate Nominal Ledger Chart of
Accounts have been configured as CIS Tax Liability.
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4 Range of Integration Options

The table below illustrates a few of the huge range of possibilities available with TASflex:

Worksheet

Function

Description

1 —Nominal Ledger

Trial Balance for Current Year to Date

Lists the Trial Balance Debits & Credits and
displays the Profit/Loss for the current year to date

Post a Nominal Journal

Posts a typical monthly Depreciation journal to 6
different CoA records

Built-in Lookup Form

Use the built-in Lookup Form to find and select a
Chart of Accounts record

2 — Sales Ledger

List Customers’ details

Lists all the TAS Customers with their Name,
Postcode, Credit Limit and Outstanding Balance

List Details & Open items for
Customer X

Use the built-in Lookup Form to find and select an
existing TAS Customer, then list details of
Customer X and any outstanding Financial
Transactions (‘Open items’)

Add a new Customer

Create a new TAS Customer record (the process
for adding a Supplier is virtually identical)

Update a Customer

Use the built-in Lookup Form to find and select an
existing TAS Customer, then amend the record
(the process for updating a Supplier is virtually
identical)

Post a Sales Ledger Invoice

For £400 Net with mixed VAT Rates to SURREY
BUS

Post a Sales Ledger Credit Note

For £200 Net with mixed VAT Rates to SURREY
BUS

Post a Sales Ledger Receipt

For £250 from SURREY BUS

Allocate Cash/Credit to Invoice

Built-in Lookup Form

Use the built-in Lookup Form to find and select a
Customer record

3 — Purchase Ledger

List Suppliers’ details

Lists all the TAS Suppliers, in Supplier name
order, with their Name, Postcode, Credit Limit and
Outstanding Balance

List Open Items for Supplier X

Lists any outstanding Financial Transactions
(‘Open items’)

Built-in Lookup Form

Use the built-in Lookup Form to find and select a
Supplier record

4 — Cash Book Post a Cash Book Receipt — Home For £250 Net with mixed VAT Rates
Post a Cash Book Payment — Home For £150 Net with mixed VAT Rates
Post a Cash Book Inter-Bank Transfer £200 from Bank Account number 1 to
Transfer Payment Bank Account number 2

5 — Stock List Products Lists all TAS Products with their Name/Description

New Product

User input box for new Product Code of new
Product record with simple pricing

List Dynamic Discounts

Lists all Customer-Product Dynamic Discounts

List Assembly Parts

Lists all Assembly Products’ Codes with their
parts’ Product Codes, sequences and Quantities

Add Assembly Part

From lookups select existing Assembly Product
Code and select a part Product code to add to the
selected Assembly

Post Stock Adjustment

Build Assembly

Post SOP Sales Invoice/Credit Note

Post a fully detailed Sales Invoice to TAS with all
line items. Same for Credit Note.

6 — Sales Orders

Create Sales Order

Add sales orders from an eCommerce system

Update Sales Order

Add extra lines, e.g. delivery charges

7 — Purchase Orders

Create Purchase Order

Create back-to-back purchase order

8 — SIM API

List Companies, Users & Applications

3 methods

Add Company

Create a company from an existing TAS dataset

Add User

Integrate Application

Integrate an Application to a Company

Give User Access to Application

Let user access an application with a specific
company
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4.1 Connect and Login to the TAS Company

The developer must establish a database connection to the TAS company. The physical location of
the database is established by setting the correct folder path to the TASBooks Company dataset and
then assigning the user name and password.

4.2 Working with the Chart of Accounts

Nominal accounts can be accessed through TASflex's ChartOfAccounts system. TASflex navigates
these and can retrieve what you require.

4.3 Working with Customers & Suppliers — Trading Partners

Customers and Suppliers can be accessed as [TradingPartners.

4,31 Retrieving Trading Partner Data

The developer can set whether or not you want to include any suppliers in a list and in what order you
want the records presented. TASflex can then retrieve a specific customer record, either by using the

built-in Lookup Form (see the Navigation section in the Appendices for details of the form) like this, or
by specifying an individual customer/supplier.

4.3.2 Maintaining Trading Partner Data

TASflex lets you add a new Trading Partner or update an existing Trading Partner.

4.4 Working with Financial Transactions - the Single Ledger

All types of Financial Transations are held within the TAS Books Single Ledger. There are some 50
different types of transaction or journal.

441 Retrieving Journal Transactions

TASflex lets you have the order set in which the Journal Lines are sorted upon retrieval and set filter
properties, e.g. by Source Ledger, Include Closed Items, Include Open Items, Posting Date From,
Posting Date To, Posting Number, Trading Partner Code From/To etc.

44.2 Posting Journals

Most of the 50-odd different TAS Journal types are handled by TASflex, including adding the various
the types of VAT information.

44.21 Foreign Currency Journals

TASflex supports Foreign Currency transactions in the TAS Financial Ledgers.
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4.5 Working with Products & Stock Transactions

4.51 Working with Products

It is important to note that Products/Stock is only available with the TASflex Plus product and this
option needs to be purchased and activated to allow access to Stock (i.e. Product) records and
related features.

4511 Retrieving Product Data

TASflex allows you to get the the order set in which you want the records. You can then retrieve a

specific product record, either by using the built-in Lookup Form (see the Navigation section in the
Appendices for details of the form), or by specifying an individual product.

4.51.2 Maintaining Product Data

TASflex lets you add a new Product Record and update an existing Product Record (e.g. to change
the product’'s name or price).

4513 Free Format Text Blocks

Free Format Text Blocks can be accessed by users during manual Sales Order entry and contain pre-
setup ‘blocks’ of repetitive text which can be auto-populated into the Sales Order body lines, thus
saving the user having to remember and type the text. With TASflex you can create and update Free
Format Text Blocks in a similar way to Products described above.

4514 Dynamic Discounts

Dynamic Discounts can be accessed by users during manual Sales Order entry and contain pre-
setup special Customer-Product percentage discounts — in effect, allowing special customer pricing
for specific products - which can be auto-populated into the Sales Order body lines, thus saving the
user having to remember that a discount exists for that Customer-Product combination. With TASflex
you can create and update Dynamic Discounts in a similar way to Products described above.

4.51.5 Assemblies and Assembly Parts

TAS supports single-level Assemblies and TASflex lets you create and update these, by adding and
deleting components, i.e. AssemblyParts.
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4.5.2 Working with Stock Transactions

It is important to note that Stock Transactions is only available with the TASflex Plus product and this
option needs to be purchased and activated to allow access to Stock (i.e. Product) records and
related features.

All types of Stock Transations are held within the TAS Books Stock Ledger. There are 6 main types
of Stock Transaction in TAS Books (a 7" and 8" type are not available in TAS); most of them are
handled by TASflex and they are all as set out in the table below:

TASLink

# Source Type Version Notes

1 Stock Stock Adjustment +/- v1.01 Only applies to products that are “Regular” stock type
product records — cannot be used to adjust Assembly or
Non-Stock types of product/service.

2 Stock Build/Unbuild v1.01 Only applies to products that are “Assembly” type

Assembly product records

3 SOP Sales Invoice v1.01 Sales Invoices and Credit Notes generated in another
system can be posted in full by TASLink, including all

4 SOP Sales Credit Note v1.01 body line items; TASLink auto-generates the related
Financial Journal, VAT Register, Stock etc updates.

5 POP Goods Receipt - Future

6 POP Purchase Invoice - Future

7 POP Goods Return n/a Not yet available in TAS

8 POP Purchase Credit Note n/a Not yet available in TAS

45.21 Stock Processing
TASflex means you can set the order in which the Stock Transaction Lines are sorted upon retrieval.
4.5.2.2 Post Stock Adjustment

TASflex lets you post adjustments to ‘Regular’-type Product’s stock values, thus increasing or
decreasing the Quantity in Stock value. This process adjusts these and the Product’s summary
In/Out values, creates Stock Transaction records and auto-creates the required Financial Journals
with related updates to the summary records.

4523 Build/Unbuild Assembly

TASflex lets you increase or decrease the Quantity in Stock values of ‘Assembly’-type Products by
using the BuildAssembly function. This process adjusts these values, not only for the ‘parent’
assembly product, but also for the component parts, as defined in AssemblyParts. The function
updates all the involved Products’ summary In/Out/Used values, creates Stock Transaction records
and auto-creates the required Financial Journals with related updates to the summary Financial
records based on the products’ unit cost prices.

4.5.3 SOP Sales Invoice Processing

You can use TASflex to process the full Invoice Header and Body line items into TAS. This not only
updates all the involved Products’ summary In/Out/Used values, creates Stock Transaction records
and auto-creates the required Financial Journals with related updates to the summary Financial
records based on the products’ unit cost prices, but it also lets the user ‘drill-down’ to view the Invoice
from within the Financial Ledger sections within TAS.

Important Note:

If the TAS Customer’s Price Type is flagged as Retail including VAT and TAS is not set up so that
VAT is calculated per line (rather than on the total net amount of the invoice) an error will be returned
because TAS must be set up to calculate VAT per invoice line if Retail pricing is used. Also, with
such customers, all unit prices passed in are set as including VAT.
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4.6

Working with Sales Orders

It is important to note that Sales Orders is only available with the TASflex Plus product and this option
needs to be purchased and activated to allow access to Sales Orders and related features.

Sales Orders are held within the TAS Books Sales Order Ledger. There are 4 different types of
order, as set out in this table:

#

Sales Order Type

Notes

1

Quotation

Does not affect Stock Quantity values.
Can be amended at any time.
Can be converted to a Proforma Invoice or to a Sales Order.

Proforma Invoice

Does not affect Stock Quantity values.
Can be amended at any time.
Can be converted to a Sales Order.

Sales Order (Invoice)

Does affect Stock Quantity values.

Can be amended at any time until fully posted.

Cannot be be converted to a Credit Order or back a Proforma Invoice or
Quotation.

When fully ‘printed and posted’ it cannot be amended.

Credit Order (Note)

Can (optionally) affect Stock Quantity values, i.e. where goods are being returned
to Stock for resale.

Can be amended at any time until fully posted.

Cannot be converted to any other Sales Order Type.

When fully ‘printed and posted’ it cannot be amended.

4.6.1

Creating Sales Orders

You can have Sales Orders created including adding text lines.

4.6.2

Retrieving Sales Orders

TASflex lets you have Sales Orders retrieved, including how they are sorted. It can then provide a
lookup to allow you to select a particular Sales Order or the developer can specify a particular Sales
Order to retrieve.

4.6.3 Updating Sales Orders

Having retrieved a Sales Order as described in the previous section, TASflex lets you have it updated
if it has not been completed.
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4.7 Financial Collections Objects

4.7.1 Financial Collections Objects Summary

The following table summarises the Collections Objects in the order in which they are stated in the

Object Model.
Object Section Description
VAT Rates Company Setup Collection of up to 20 VAT _Rate objects
BankAccounts Company Setup Collection of up to 100 BankAccount objects
Countries Company Setup Collection of about 270 Country objects
CurrencyRates Company Setup Collection of about 150 CurrencyRate objects
ChartOfAccounts Single Ledger Collection of ChartOfAccount objects

NominalGroups

Single Ledger

Collection of NominalGroup objects

FinancialJournalLines

Single Ledger

Collection of FinancialJournalLine objects

VAT Journals

Single Ledger

Collection of VAT Journal objects

ForeignCurrencyJournals

Single Ledger

Collection of ForeignCurrencyJournal objects

TradingPartners

CustomerDeliveryAddresses

Customers & Suppliers
Customers & Suppliers

Collection of TradingPartner objects

Collection of CustomerDeliveryAddress objects

CustomerGroups Customers & Suppliers Collection of CustomerGroup objects
SupplierGroups Customers & Suppliers Collection of SupplierGroup objects
SalesPeople Sales Analysis Collection of SalesPerson objects
MarketingCodes Sales Analysis Collection of MarketingCode objects
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4.3 Financial Single Objects

4.8.1 Financial Single Objects Summary

Object Section Description

TASBooksAccountingCompany System The root object of the SDK

Status System Current status following call to SDK. It could be information,
a warning, database operation status/error, runtime errors,
business rule violations

TAS_Setuplinfo Company Setup The core setup and configuration settings for the TAS Books
dataset; these are configurable by Supervisory users in TAS
Books

VAT Rate Company Setup One of up to 20 VAT rates supported by TAS

BankAccount Company Setup One of up to 100 bank accounts that can be set up in TAS

Country Company Setup One of some 270 prepopulated Countries which can be
amended in TAS

CurrencyRate Company Setup One of some 150 Currencies whose rates of exchange can
be adjusted in TAS

ChartOfAccount Single Ledger The Chart of Account is the core accounting record which

provides the main summary figures for the Trial Balance and
Financial Statements in all accounting systems

NominalGroup

Single Ledger

A Nominal Group record holds summary values of any Chart
of Accounts records assigned to it by the user

FinancialJournal

Single Ledger

A top level ‘holding’ record for each set of Financial Journal
Lines, which must ‘balance’, i.e. the total of all debit (+)
amounts must equal the total of all credit (-) amounts

FinancialJournalLine

Single Ledger

The Financial Journal Line is the core ‘Double Entry’
transaction record in the Single Ledger

ForeignCurrencyJournal

Single Ledger

A record of any foreign currency transaction associated with
the main FinancialJournal object

VAT_Journal

Single Ledger

A record of any Value Added Tax associated with the main
FinancialJournal object

TradingPartner

Customers & Suppliers

TAS handles Customers and Suppliers as essentially one
entity which can also be both a Customer AND a Supplier;
this makes special types of transaction, such as Contras
between the Sales and Purchase Ldgers, easy to implement

CustomerDeliveryAddress

Customers & Suppliers

TAS allows an effectively unlimited number of Delivery
Addresses per Customer

CustomerGroup

Customers & Suppliers

A Customer Group record holds summary values of any
customer Trading Partner records assigned to it by the user;
there is one preset default group (‘'DEFAULT’)

SupplierGroup

Customers & Suppliers

A Supplier Group record holds summary values of any
supplier Trading Partner records assigned to it by the user;
there is one preset default group (‘DEFAULT’)

SalesPerson

Sales Analysis

A SalesPerson record holds summary values of each Sales
Person set up by the user; there is one preset default Sales
Person (‘DEF’). Each Customer is assigned its default
Sales Person

MarketingCode

Sales Analysis
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4.8.2 Financial Journal Types

The different types of TAS Financial Ledger Journal are set out in the table below.

# Financial Journal Transaction Types handled

1 CashBook Payment EC

2 CashBook Payment HomePurchase

3 CashBook Payment NonEC

4 CashBook Payment NonVATJournal

5 CashBook Payment VAT Refund

6 CashBook Payment InterBank Transfer

7 CashBook Receipt EC

8 CashBook Receipt Homelnvoice

9 CashBook Receipt NonEC

10 CashBook Receipt NonVATJournal

11 CashBook Receipt VATRefund

12 CashBook Receipt InterBankTransfer

13 Nominal Ledger General Journal

14 Purchase Ledger CreditJournal

15 Purchase Ledger CreditJournal Bounced Cheque
16 Purchase Ledger CreditJournal Refund

17 Purchase Ledger CreditJournal WriteBack

18 Purchase Ledger DebitJournal

19 Purchase Ledger DebitJournal Write Off

20 Purchase Ledger DebitJournal ContraWithSales Ledger
21 Purchase Ledger Invoice

22 Purchase Ledger CreditNote

23 Purchase Ledger Payment

24 Purchase Ledger Payment Cash

25 Purchase Ledger Payment ePayment

26 Purchase Ledger Payment Other

27 Purchase Ledger Payment CCard

28 Purchase Ledger Payment Cheque

29 Purchase Ledger Payment Transfer

30 Purchase Order Processing Invoice

31 Sales Ledger CreditJournal

32 Sales Ledger CreditJournal WriteOff

33 Sales Ledger CreditJournal ContraWithPurchase Ledger
34 Sales Ledger DebitJournal

35 Sales Ledger DebitJournal BouncedCheque

36 Sales Ledger DebitJournal Interest

37 Sales Ledger DebitJournal Refund

38 Sales Ledger DebitJournal WriteBack

39 Sales Ledger Invoice

40 Sales Ledger CreditNote

41 Sales Ledger PaymentReceipt

42 Sales Order Processing Invoice

43 Sales Order Processing CreditNote

44 StockProcessing StockAdjustmentAssemblyBuildBody Positive
45 StockProcessing StockAdjustmentAssemblyUnbuildBody Negative
46 StockProcessing AssemblyBuildParent Positive

47 StockProcessing AssemblyUnBuildParent Negative
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5 TASflex Plus — Additional Objects
5.1 Commercial Collections
5.1.1 Commercial Collections Objects Summary

The following table summarises the Collections Objects in the order in which they are stated in the
TASLink Object Model.

Object Section Description

ProductGroups Stock & Products Collection of ProductGroup objects

Products Stock & Products Collection of Product (can be Service) objects
AssemblyParts Stock & Products Collection of AssemblyPart objects
FreeFormatTexts Stock & Products Collection of FreeFormatText objects
DynamicDiscounts Stock & Products Collection of DynamicDiscount objects
StockTransactionHeaders Stock & Products Collection of StockTransactionHeader objects
StockTransactionLines Stock & Products Collection of StockTransactionLine (Body) objects
SalesOrderHeaders Sales Orders Collection of SalesOrderHeader objects
SalesOrderLines Sales Orders Collection of SalesOrderLine (Body) objects
PurchaseOrderHeaders Purchase Orders Collection of PurchaseOrderHeader objects
PurchaseOrderLines Purchase Orders Collection of PurchaseOrderLine (Body) objects

5.2 Commercial Single Objects
5.21 Commercial Single Objects Summary

The following table summarises the Collections Objects in the order in which they are stated in the
Object Model.

Object Section Description
TASBooksAccountingCompany System The root object of the SDK
Status System Current status following call to SDK. It could be information,

. awarning, database operation status/error, runtime errors,
business rule violations

ProductGroup Stock & Products The ProductGroup record is a Product classification record
for the core Product records (below) which provides
summary analysis and figures for the Stock system.

Product ¢ Stock & Products The Product (or Service) record is the core Stock record
which provides the main summary figures for the Stock
system. Assembly type Product records have 1 or more
components. TAS does not support sub-assemblies.

AssemblyPart Stock & Products There must be 1 or more AssemblyPart records, i.e.
: components, per Assembly.
FreeFormatText Stock & Products TAS users can call pre-setup Free Format Text blocks whilst
entering Sales and Purchase Orders
DynamicDiscount Stock & Products These are TradingPartner_Customer+Product combinations

to allow special discounts on a per product basis to
individual customers; these discounts are used during Sales
Orders entry.

StockTransactionHeader Stock & Products All Stock Transactions consist of a Header record plus at
: least one Line (body) record.

StockTransactionLine Stock & Products One or more Stock Transaction Line (body) records make
up a Stock Transaction.

SalesOrderHeader . Sales Orders All Sales Orders consist of a Header record plus at least one

Line (body) record.

SalesOrderLine Sales Orders One or more Sales Order Line (body) records make up a
Sales Order.

PurchaseOrderHeader Purchase Orders All Purchase Orders consist of a Header record plus at least
one Line (body) record.

PurchaseOrderLine Purchase Orders One or more Purchase Order Line (body) records make up a

Purchase Order.
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5.2.2 Commercial Single Objects Enumerations
Object Type Enumeration #
Product Product_PrimarySalesTypeFlags Goods
Service
FreeSample
Install_And_Assemble
ProductTypeFlags Regular
Assembly
Non_Stock

SalesOrderHeader

IntrastatDeliveryModes

NotApplicableDeliveryMode

Sea

Rail

Road

Air

Post

NotAllocated

FixedlInstallation

InlandWaterway

OwnPropulsion

IntrastatDeliveryTermsFlags

NotApplicableDeliveryTerms

ExWorks

FOB

CIF

DDU

Other

PrintingPostingStatusFlags

PrintedCompleted

NotCompleted

PartCompletedOutstanding

PrintedNotPosted

SalesOrderTypes

Quotation

,Proformalnvoice

Invoice

CreditNote

VAT_TypeFlags

HomeCustomers

EC

NonEC

OutsideScope

Exempt

SalesOrderLine

ProductTypeFlags

Regular

Assembly

Non_Stock

StockTransactionHeader

CommissionBasisFlags

Sales

Margin

IntrastatDeliveryModes

NotApplicableDeliveryMode

Sea

Rail

Road

Air

Post

NotAllocated

FixedInstallations

InlandWaterway

OwnPropulsion

IntrastatDeliveryTermsFlags

NotApplicableDeliveryTerms

ExWorks

FOB

CIF

DDU

Other

OrderLineDiscountMethods

None

UnitPrice

ExtendedPrice

StockTransactionGroups

Purchase

Movement

Sale

StockTransactionTypes

Adjustment
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Object

Type

Enumeration

+H*

CreditNote

Receipt

VATInvoiceCalcMethod

LineByLine

TotalByRate

StockTransactionLine

MovementTypeFlags

IntoStock

OutOfStock

StockTransactionGroups

Purchase

Movement

Sale

StockTransactionTypes

Adjustment

Invoice

CreditNote

Receipt

[z~ |>|wn|=Z|olo|— |- ||z
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6 SIM Launched Control Centre Modules
6.1 Module Menu & Functions Summary

6.1.1 Main Menu Form

When you successfully launch the module program you are presented with a Main Menu form, which
may vary slightly depending on the module. An example is:

il TAS Link Control Centre (Runtime Edition) M=1E3
File View BES08 Help

Company Options Ctrl+0

|User Options Ctrl+
Implicit Runtime Settings Ctrl+I

Yer: 0.00 Uzer: ADMIN [Unregistered] | TAS Demonstration Company [C:ATAS Bookz JADEMO1])

6.1.2 Menu Functions

All functions are accessed via a standard Windows type menu bar at the top of the Main Menu form of
each Module. Depending on the module selected, options are File, View, Tools and Help.

Clicking on any of these options produces a drop down sub-menu allowing further function selection,
organised as set out in the table below.

# ‘ Dropdown Level 1 Functions Runtime | Developer
File 1 View Text Files v v

2 Printer v v

3 Exit v v
View 4 | SDK Audit Log v v
Setup 5 Company Options v v

6 User Options v v

7 | Implicit Runtime Settings 4 4
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6.1.3 Version & User ID

The status bar at the bottom of the form has 4 sections to display information:

¥
Yer: 0.00 Uszer: ADMIN [Unregistered]  TAS Demonstration Company [C:ATAS Books 3ADEMO1]

Section Name Description

Left 1 Ver Module’s program Version in the format 9.99. If you hover your mouse over the
section a tool tip displays the Version plus the Build numbers in the format
9.99.9999; this is useful to determine that you have precisely the correct

program
Left 2 User Your SIM User ID
Centre Normally blank, but can be used to display messages or prompts for you
Right Company The Company Name as set up in TAS
Folder The Data Path for the target TAS company, i.e. its folder location either on your

PC’s local drive or on the network

The folder information should correspond to the information displayed in the TAS Multi-Company
Selection form which is displayed each time you launch TAS (unless you have selected the option to
auto-load the company on launching TAS):

—

& TAS Books 3 - Multi-Company Selection
File Company Help

Select Company

Company Mame Data Directary Last Backup
2] TB3w5.08 Demonstration Company CNTASYTE3W 5058\DEMO 1

Important — Network Paths

To help avoid confusion in Network installations it is strongly recommended that
UNC paths are used instead of mapped drive letters.

For example: \\OurServer\TB3Data\Data1 instead of T:\Data1.
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6.2 File Menu

6.2.1 View Text Files

This is a basic text file viewer, that allows you to open, view and print any text file or your system but
in particular allows the viewing of the log files that are generated by any import/update function of this
program. On selection of this option you are presented with a blank text file viewer screen. There is a
File option on the menu. Select Open to browse to the file you want to view, as shown below.

Open [E
Lockin: [ DEMO1 | £¥ E-
_g BadData.Log
L fileinteq.log
My Recent PCat_Chg.log
Documents PROD_2003-10-17_01.LOG
@ prod_imp.log
PRODUCT.LOG
Desktop Revalue.Log
. SOIMP_2003-10-17_01.L0G
U S0IMP_2003-10-21_01.L0G
soimpart.log
Documents | /=
~gbre E s fransact.log
Dopey
‘g File name: | j Open
My Netwo Files of type: |Log Files (*log) ~| Cancel
Pl
=ces [ Open as read-only

The browser defaults to the TAS company data folder and to files of the ‘Log Files’ type, but you can
change these to suit.

Version 2.3, 01 Nov 2010 Page 28



Infoplex Ltd Reference Manual TASflex

When you have selected the file, its contents are displayed:

il View Text File - Cust_IMP_2006-01-08_01

File:
Infoplex Log File,Original Filename:,C:\TAS Books 3\Datall\Cust_IMP.LDG ~
Module: ,Sales Ledger Imports for TAS
Version:,1.11,TAS Type: TB3,
TAS Ver:,5.08&,TAS Path:,C:\TAS\TESWS08\DEMD1\
Started on:,Sunday, Jan & 2006,at:,08:14:06 PU
[Account Code 'CUSTO00Ll' - Line 1 - WARNING: VAT Type invalid [] - retaining current value.
Locount Code 'CUSTO001' - Line 1 - WARNING: VAT Type invalid [] - retaining current wvalue.
Account Code 'CUSTO001l' - Lime 1 - WARNING: Credit Card Issue Month inwvalid [1 - defaulting to 0.
[Account Code 'CUSTO001l' - Line 1 - WARNING: Credit Card Expiry Month invalid [1 - defaulting to O.
LZocount Code 'CUSTO001' - Line 1 - WARNING: Send Mailings invalid - , defaulting te '¥'
Account Code 'CUSTO001l' - Line 1 - Customer updated.
Locount Code 'CUSTO002' - Line 2 - WARNING: VAT Type inwvalid [] - retaining current wvalue.
Aoccount Code 'CUSTO002' - Linme 2 - WARNING: VAT Type inwvalid [] - retaining current wvalue.
Account Code 'CUSTO00Z2' - Line 2 - WARNING: Credit Card Issue Month invalid []1 - defaulting teo 0.
(Account Code 'CUSTO002' - Line 2 - WARNING: Credit Card Expiry Month invalid []1 - defaulting to O
Account Code 'CUSTO002' - Line 2 - WARNING: Send Mailings inwvalid - , defaulting teo 'Y’
Account Code 'CUSTO000Z' - Line 2 - Customer updated.
Account Code 'CUSTO002' - Line 2 - WARNING: Start Date mot in corrvect format - defaulting to todays date.
Account Code 'CUSTO003' - Line 3 - WARNING: Sales Persom invalid - defaulting to DEF
[Account Code 'CUSTOO03' - Line 3 - WARNING: VAT Type inwvalid [] - retaining current value
Account Code 'CUSTO003' - Line 2 - WARNING: VAT Type inwvalid [] - retaining current wvalue.
Account Code 'CUSTO003' - Line 3 - WARNING: Credit Card Issue Month invalid []1 - defaulting teo 0.
(Account Code 'CUSTO003' - Line 3 - WARNING: Credit Card Expiry Month invalid [] - defaulting to O
Account Code 'CUSTO002' - Line 2 - WARNING: Send Mailings inwvalid - , defaulting teo 'Y’
Account Code 'CUSTO003' - Line 3 - Customer updated.
Account Code 'CUSTO004' - Line 4 - WARNING: Customer Comtact Salutation inwalid - , defaulting to 'Sirs’.
Account Code 'CUSTO0004' - Line 4 - WARNING: Customer Contact invalid - , defaulting to 'F'.
[Account Code 'CUSTO004' - Line 4 - WARNING: Accounts Contact Salutation invalid - , defaulting to 'Sirs’.
Locount Code 'CUSTO004' - Line 4 - WARNING: Accounts Comtact Ending inwvalid - |, defaulting te 'F'.
Account Code 'CUSTO0004' - Line 4 - WARNING: Customer Price Type invalid - | defaulting to '1°
[Account Code 'CUSTO0004' - Line 4 - WARNING: Start Date not in correct format - defaulting to todays date.
Locount Code 'CUSTO004' - Line 4 - WARNING: VAT Type inwvalid [] - retaining current wvalue.
Account Code 'CUSTO0004' - Line 4 — WARNING: VAT Type invalid [] - retaining current value.
[Account Code 'CUSTO004' - Line 4 - WARNING: VAT Type invalid [] - retaining current value.
Zoccount Code 'CUSTO004' - Line 4 - WARNING: Credit Card Issue Month inwvalid []1 - defaulting te 0.
Account Code 'CUSTO0004' - Line 4 - WARNING: Credit Card Expiry Month invalid []1 - defaulting to 0.
Account Code 'CUSTO004' - Line 4 - WARNING: Send Mailings invalid - , defaulting to 'Y’
Locount Code 'CUSTO004' - Line 4 - Customer updated.
[Account Code 'CUSTO0005' - Line 5 - WARNING: Customer Contact Salutation invalid - |, defaulting to 'Sirs’.
Locount Code 'CUSTO005' - Line 6§ - WARNING: Customer Comtact invalid - , defaulting to 'F'.
Account Code 'CUSTO005' - Line 5 — WARNING: Accounts Comtact Salutation inwvalid - |, defaulting to 'Sirs’.
(Account Code 'CUSTO0005' - Line 5 - WARNING: Accounts Contact Ending invalid - , defaulting to "F'.
Locount Code 'CUSTO005' - Line 6§ - WARNING: Contact Fax too long, truncated to 20 characters.

s Coge o opioT e L £ AODMTHC . Cocs I. o : il Hefocalis FET R b
Save as

Once a file has been opened it can be saved as an alternative file name in any folder you select.

Print Setup

This option takes you to your standard Windows printer setup dialogue options.

Print
Prints the text file on display.

Close
Closes the text viewer window.

6.2.2 Printer

This option takes you to your standard Windows printer setup dialogue options.

6.2.3 Exit

This option closes the program and records you as logged out of that Module/Company combination.
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6.3 View Menu

6.3.1 SDK Audit Log

[##Future release]
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6.4 Setup Menu

6.4.1 Company Options

Important — Record Locked

Whilst this function is active the TASLink application’s Central Setup Information
record is locked to other users

[##Future Release]

This function lets you make changes to the SDK'’s Central Setup Information, which contains global
default values and preferences to control how the SDK behaves. All of the TASLink options, which
are automatically set to default values when the system is first run, are displayed in a grid and are
grouped for easy maintenance. Each group can be expanded or collapsed as required by clicking on
the +/- button in the 1% column of the selected group.

=
il TAS Link - Company Options

Group / Sub Group | Property Walue | o
1| Mominal Ledger Postings 0|
Allow Postings to Control Accounts [Mat Recommended!] [ [l
S ales Ledger Cantral =]
Purchaze Ledger Control =]
WAT Contral =
Bank Accounts =
Profit & Loss [
ﬂl:a:h Book Postings el
Allowy Postings to Control Accounts (Mot Recommended!] =]
Sales Ledger Cantrol =
Purchaze Ledger Control (=
WAT Control =
Eank Accounts =
Profit & Loss r
jSuspense Account Postings 2l
Allow Poztings to Suspense Account (i
Mominal Ledger Journals [
Sales Ledger Journals =]
Purchaze Ledger Journals =]
Cash Book Journals =
ﬂPn:ling to Clozed Periods el
Allow Posting ta Closed Periods [
Mominal Ledger Jounals =]
Sales Ledger Jounals [
Purchase Ledger Journals =
Cash Book Journals r
ﬂSelling Nominal A t active/inactive status [From TAS +5) 2l
Allow Setting Mominal Account activefinactive status (=
Allowe zetting Active Mominal Account to Inactive [
Allow setting Inactive Naminal Account ta Active i -
‘ v
Save Cancel
TAS Link Control Centre (D eveloper E dition] Company Options 0B/05/06 1215
Yer: 1.01 User: ADMIN [Unregistered) TB3 vb.x Demonstration Company [C:A\TAS Books 3\DEMO1)

Once you are happy with the options, click the Save button to apply the changes; this unlocks the
Central Setup Information record and closes the form. If you want to discard all changes made then
click Cancel; this unlocks the Central Setup Information record and closes the form without applying
any changes you may have made.

6.4.2 User Options

[##Future release]
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APPENDIX A Installation, Setup & Launch

A1 Installation

You will have been sent an installation CD for the Infoplex System Integration Manager (SIM) and the
TASflex and Control Centre module(s).

The TASflex Control Centre module can only be installed and used from within SIM. If you have not
already done so, please install SIM first. Please refer to the SIM Manual on your SIM installation CD
for details of how to install and use SIM.

To install your TASflex Control Centre Module
If installing from CD media, insert your Installation CD into your CD-ROM drive. Log into SIM as
'ADMIN' and select Tools > SIM Modules > Configure from the menu bar at the top of the screen.

il System Integration Manager - Maintain Modulas

* Applications " |ntegrate

Registered on | Trial Expiry InfoCover Exping
Mot Feq. 1THIN0A 17H03
Mot Req. 1THIN0A TH0a

Remove | Close |

ADMIN | SIM v4.50

Click the Applications radio button then click Add/Upgrade, which opens the SIM “Add/Upgrade
Modules” window.
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Click the Locate Setup File button and use the “Browse for Folder” dialogue to select the folder on
the CD (or elsewhere) which contains the TASflex Control Centre installation files. For example this
may be:

D:\Packages\TASLink for TAS Link Control Centre (where “D:” is your CD-ROM drive) and click OK.
Check that you have the correct Application and click Continue.

i System Integration Manager - Add/Update Modules x|

Usze the “Locate Setup File” button to browsze to the folder on the CD or
elzewhere containing the installation files of the Application Module you wizh to
Add/Upgrade

Current Setup Location : ShDochDatasnstal_SetshTAS LinkhDeveloper Eitseetup.inf

Application |"."E'r5iDI'|| In=tall { Upgrade | Awailable | Comments
TAS Link [Deweloper Edition) 0.an Install ‘fes Application install available.

k

Locate Setup File Contirie | Cancel ||

In the “Select Applications” form tick the box next to Infoplex TASflex Control Centre for TAS and click
OK. Answer YES in “Setup Verification” to confirm you wish to Install/Upgrade the selected
application.

I|||I‘I System Integration Manager - Select Applications El

Pleaze zelect the application software module[z] you wizh to
Inztall £ Upgrade.

TAS Link [Developer

Apphcation Setup Type: Mew Application “Werzion:
| Install | 0.00

== |MPORTAMNT ===
| have read and understood the terms of the legally binding
Software Licence Agreement which was displayed on the
second screen of the original main installation, a copy of which
iz alzo contained on the System Integration Manager installation
dizk under the file name Licence. txt. By clicking the "0K"
button below | agree to be bound by the terms and conditions of
the agreement as set out. If | do not 20 agree | will dizcontinue
installation of the software by clicking the "Cancel™ button.

k. Cancel
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When the installation is complete a Setup Log is shown which may be printed if required; click Close

to continue.

System Integration Manager - Setup Log {Install Stage)
Starhing Setup.

Proceszsing application : MULTITAS SaALES LEDGER
Application verzion found.

Application wpe found.

Tnal penod found.

Directary 5% processed.

WTEWSLImp. exe copied to destination.

Successfully unregiztered COM Server "TASLink. dlI".
WTASLink.dll copied to destination.

Successfully registered COM Server "TASLink.dll",
Successfully unregiztered COM Server "SIMLink. dII".
WSk Link. dll ot copied o destination.

Successfully registered COM Server "SIMLink.dIl".
Directary Zemptedb® processzed.

WppCent. bi copied o destination.

YMHames'Wk1.bi copied to destination.

WDocGbha bi copied to destination.

“DocTelef Bl copied to destination,

WDocBDYWW Bl copied to destination.

WrlEemw1 Bl copied to destination.

YStdSLCRT . ipt copied to destination,
WSHdSLCRZ.RPT copied to destination.

Prirt

Cloze

Version 2.3, 01 Nov 2010

Page 34



Infoplex Ltd Reference Manual TASflex

A2 Setup Integration to TAS Company

Before you can use TASflex you must create an integration link between it and your TAS Company
and enable user access rights. This is done still using SIM’s Tools > SIM Modules > Configure;
click the Integrate radio button at the top right of the screen, highlight TASflex in the list and click the
Add button.

rA

I||||‘I System Integration Manager - Maintain Modules ﬂ

Py o
" Applications & |ntegrate

| Application Module | .ﬂ.ctil.lel Application Tgpe| 'u'ersionl Installed on | Registerad on | Trial Expiry | Support Expiry | I
T&5 Link. [Developer Edition] es Infople: Pha. 0.an 0303006 Mot Feq. 07042006 O7I05{2006

il Integration Added. - 10] x|

Integration successfully added.

Uzerz muzt now be given acceszs to uze thiz module-
company combination in 51k by zelecting
"Toolz"-»"5IM Ueers'-> "Configure Access Rights"

Inztalled on

Remove

Cloze | =

’:|ADMIN | it v3.01

Eﬂﬁtartl“ E:- @ @ |J H]Imﬁystem Integration Mana... 11:27
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A3 Add User Access rights for the module with the TAS Company

Next you must add User Access rights to TASflex for this Company. Do this by using SIM’s
Tools > SIM Users >Configure Access Rights:

(il S¥stem Integration Manager - User ACcess [_ (O]
Lser:  [ADmIM Swstern Adminiztratar Supervizor User

Application b odule
TAS Link [Developer Edition]

Company
n Compary

SADEROT

Compary D ata Farmat Acoess

-
1 v[ ]

............ Edlt ............. giscnntinue |

LCloze

A0MIM Sl 301

Select the User by pressing F2, highlight the TASflex Application Module and click the Add button:

(i System Integration Manager - New access =]
UserlD:  [aDMIN application :  [TAS Link [Developer Edition]
Company : [T&5 Demonstration Company
Option Access ez Mo
| Compaty Optionz Supervizory Rights
| Implicit Buntime Settings Qo
v] SDF. Audit Log Edit / Delete Rights
"l Ll=er O phions n ~
TAS UzerlD
SR
=
Select All
Clear Al
k. | Cancel

Tick those options to which the selected user should have access and select whether or not they
should have Supervisor rights and/or Edit/Delete rights.
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A4 Launching TASflex Control Centre

From SIM’s main screen select the the TAS Company with which you work (double-click), then select
the TASflex Control Centre module and then double-click it or click OK to start it. At launch, SIM
checks the program’s version number against its database of installed programs. SIM also checks
that the TAS Company’s Data version (still) matches that in its own record for the target TAS
company dataset. If either of these do not match, you are presented with an error message and, to
avoid possible data corruption, SIM stops the launch from proceeding further. As a further security
safeguard the program cannot be launched successfully directly from Windows; if a user attempts to

do this, an “Invalid Startup” error message is displayed informing you that the program can only be
launched from SIM.

il System Integration Ma Y [m] P
File Tools Help

IL::u:aI SIk Database: C:\InfHome'

LCompanies | Meszage Log I

Compar [ratapath Comments —

| TAS Demongtration CompanyC:45TAS Books 3 w5ADEMO

it select which 5IM Module to run i | m]

Fleaze zelect the module that vou wizh ta run from the ligt below, and press OF.

[x

745 Link [Developer Edition] You have access to launch thiz module with this company

||>|L|L

4 |

[

ok LCancel Help
| ADMIN | Select the module you wish to use, and click "OK" BIM Va0l
1 | L
taore Detail = Open
|.-’-'-.DMIN | Pleaze Double-Click on the the compary you wizh to work, with |v3.EI'I [ 5

When the program is launched from SIM it checks its own compatibility against the version which SIM
states to it and against the version of TAS data at which it has been launched; if it finds that it is
incompatible in either case you receive an error message and the program exits. It also checks the
Application Central Information file to find its own application record for default values; if this is not
present, indicating that this is the first time the program has been run, it may warn you to configure
and set these up. Once the application has been successfully launched, you are presented with the
Module Main Menu form - see Module Menu & Functions Summary.
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A5 Data File Upgrade

If you have just installed a module upgrade in SIM and are running the module for the first time with
this company, you receive an upgrade warning:

Sales Ledger Imports - Data Yersion Upgrade

AN

Application data file upgrade required.
Sales Ledger Imports Program Ver: 1,036 [1.08.00037]
Sales Ledger Imports Data Ver. : 1.07 (or earlier)

The data files were created with an older version of Sales Ledger Imparts,
and cannot be used with this program version without first upgrading
the data files,

Do you want to run the data file upgrade now?

Click Yes to continue. You are asked to confirm that you want to proceed:

Sales Ledger Imports - Confirm Data File Upgrade

Are you sure you want to upgrade your data files from wersion 1.07 (or earlier) to 1.08 now?

\:E,) [n.b. This upgrade is irreversible, ]

Yes, I really do wish to upagrade to version 1.08

Click Yes to continue.
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When the data upgrade is complete, you can continue to launch the module:

Sales Ledger Imports - Data File Upgrade Complete

!

The data files have been successfully upgraded from version 1.07 {or earlier)
to 1.08.

Do you want to run the program now?

A.6 De-Installation

To de-install this module, first log into SIM as '"ADMIN'. Select Modules>Maintain from the menu bar
at the top of the screen. Click the Application radio button then click Remove. A warning screen is
shown asking you if you are sure you wish to do this. Click OK and the application is removed.

A7 Product Licensing

You are free to try this product for thirty days from the date of installation, following which it will time-
expire and cease to be accessible. If you wish to continue using the product after this date it must be
Registered. This is done through SIM’s Modules>Maintain>Register function - see the SIM
Reference Manual on your SIM Installation CD to see how to do this.
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APPENDIX B Database Navigation & Lookups

In SIM and the TAS Link Control Centre modules the main function keys operate in much the same
way as TAS:

Key Function Description

F2 Database navigation — Lookup Selection list

F5, F6, F7 & F8 Database navigation — Find First/Last/Prev/Next
F9 Database navigation — Find Nearest

F3 Record management — Clear form

F4 Record management — Delete

F10 Record management — Save

F11 & F12 Reserved for special functions

A sample Lookup selection list form is included and shown below, though its actual presentation will
vary in certain respects depending on the type of Lookup you are doing.

ili* Select Customer... |:|[E|rz|
SortSearch | TR v || |
Customer Code Mame Fostcode Group Marketing Code | Sales 2
ACS Aircraft Caterng Services Ltd M17TG DEFALLT DEFAULT AN1 [T
ABCCHAUFF  ABC Chauffeurad Limousines LSA DEFALLT DEFAULT ANT
ADDICTION Addiction Limited WX 3PH DEFAULT DEFAULT DEF
ALTOURINT  Altour Intemational Credit Card LSA DEFALLT DEFAULT DEF
AMDERSENC  Andersen Consulting WC2R LT DEFAULT DEFAULT DEF
AUTOSELM Autos El Mundos 5.4, 28015 DEFALLT DEFAULT DEF
BAROMPHIL Baron Philippe De Rothschild (UK) Ltid SW71ET  DEFALLT DEFAULT DEF
BAYERAG Bayer AG DEFALLT DEFAULT DEF | _
BILLKENWR  Bill Kenwright Ltd WV BJA  DEFAULT DEFAULT DEF |=
CAPITALMA Capital Marets Assurance Corp. EC3VSDR DEFAULT DEFALLT DEF
CHARLESST  Charles Street Communications SW1A 1EE DEFAULT DEFALLT DEF
CHARLOTTE  Charotte Moss & Co M.Y.1002  DEFAULT DEFALLT DEF
COMDENAST  Conde Mast Publications Ltd WIR 0AD  DEFAULT DEFAULT DEF
DAMIELEDM  Daniel Edmund Caims M16 2BY  DEFALULT DEFALLT DEF
DOMESTIC&E  Domestic & General Group Plo SW15 4848 DEFAULT DEFALLT DEF
DRAKESGRC  Drakes Group Lid ES 4AA DEFALLT DEFAULT DEF
ELYSIUMEY Elysium Evert ManAGers Ltd KT11BJ  DEFAULT DEFALLT DEF E -
EMROMNDEVE  Enron Development Corporation 7002 DEFAULT DEFAULT DEF
L I |

Select | ShowHide | | Cancel |

Depending on the type of Lookup that you are performing you may have options for how you want to
search using the Search by dropdown menu; for example you may be able to search Customers by
their TAS Code, their Name or their Postcode. Partially typing in the search field makes the nearest
match appear in the first row of the grid. You can also use the 4 database navigation buttons on the
right of the form, the top and bottom one of which take you to the first and last record of the Search

By field. Double clicking on a column header sorts the displayed list in ascending/descending order.
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The following table sets out the columns which are displayed for different types of lookup and which
are searchable:

Lookup Table Display Columns Searchable
Customers Code

Name

Postcode

Group

Marketing Code
Salesperson
Customer Delivery Addresses Delivery Code

Name

Postcode

Contact

Tel Num

Suppliers Code

Name

Postcode

Group

Customer & Supplier Groups Group Code
Description

Marketing Codes Code

Description

Products Code

Description

Group

Bin

ANA/Barcode

Type

Discontinued

Price 1

Product Groups Group Code

Group Description
Number of Products in Group
Sales Orders Sales Order Number
Customer Code

Order Type

Sub-Type

Description

Order Date

Expected Ship Date
Salespersons Code

Name

Tel Num

Area Covered

Country Covered

Free Format Text Blocks Code

Description

Chart of Accounts Nominal Account Number
Department
Description

Group

VAT Rates Rate ID

Description
Percentage

Nominal Account Number
Nominal Department
Bank Accounts Bank Account Number
Bank Account Name
Nominal Account Number
Nominal Department
Countries ISO Country Code

EC Country Code
Name

Notes

Currencies Code

Name

Rate

Purchase Orders Order Number
Supplier Code
Description

Order Date v

NN NN NN

D VR N N N NN

NN NN NN

AN AN

AN

AN N NN AN AN N NN

AN
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Lookup Table Display Columns Searchable
Expected receipt Date
Order Completed?
Invoicing Completed? v
Supplier's Order Number v

In future versions you will be able to select which columns you want to display from a list:

ili Stock Link - Select Fields To Display

Field Mame Show | Order

‘B.ls.ls.ls.ls.hb.

QKl

Cancel |

For other functions, such as to move around forms, use:

Key Function Description

TAB Accept an entry and move to the next field
NV, €D Move to the next field — Up, Down, Left, Right
Ctrl + Insert Insert blank row on grids

Ctrl + Delete Delete row on grids

Ctri+P Microsoft standard Print dialogue box
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APPENDIX C Files/Tables Used

The above functions use the files/tables listed below as summarised in the table.

File/Table Type Notes/Remarks Function #s
AppCent.BI/SDK PSQL/Btrieve Application Central Information All
DocGbIW1.BI PSQL/Btrieve Report document’s global runtime information All Reporting
workfile
xxxxWK1.BI PSQL/Btrieve Xxxxxx Report data workfile 16
Xxxxx.LOG ASCII Text ASCII Text Log file for each Customer Import 4
run
Customer_Code_Change | ASCII Text Unique ASCII CSV Log file for each bulk/mass | 13

_YYYY-MM-DD_NN.log Customer Code Change run

Supplier_Code_Change ASCII Text Unique ASCII CSV Log file for each bulk/mass | 14
_YYYY-MM-DD_NN.log Supplier Code Change run

TAS Central Information PSQL/Btrieve To get default values All

TAS Chart of Accounts PSQL/Btrieve To validate NL account values and post to N, N

TAS Names & Addresses | PSQL/Btrieve Customer and Supplier records All SL & PL, some
ST, all SOP

TAS Customer/Supplier PSQL/Btrieve Notes for Customer and Supplier records

Notes

TAS Delivery Addresses PSQL/Btrieve

TAS Users PSQL/Btrieve For Lock/Unlock System routines All Imports

TAS SalesPeople PSQL/Btrieve Validation, Sales Orders & Analysis N, n

TAS Customer Groups PSQL/Btrieve Report selections N

TAS Supplier Groups PSQL/Btrieve As previous - but PL module All Imports

TAS VAT Rates PSQL/Btrieve VAT Rates and VAT setup validation N

TAS VAT Register PSQL/Btrieve

TAS Product Groups PSQL/Btrieve Groups for CoA records with summary values N, n

TAS Journal Transactions | PSQL/Btrieve The double entries N

TAS Stock Transaction PSQL/Btrieve

Headers

TAS Stock Transaction PSQL/Btrieve

Lines

TAS Sales Order Headers | PSQL/Btrieve

TAS Sales Order Lines PSQL/Btrieve

TAS System Audit Log PSQL/Btrieve To enable check for Product Code changes N
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APPENDIX D Change History

Version Date Item | Feature Add/Change Notes

0.00 24/03/06 1 First Phase 1 release (beta) — Financial Ledgers. Compatibility with TAS Books 1/2/3
range, versions 4.x and 5.x

1.01 02/05/06 1 Financial Ledgers (Phase 1) non-beta release. Customer Delivery Addresses support
added.

1.01 nn/06/06 1 First Phase 2 release (beta) — with Commercial Pack. Compatibility with TAS Books 1/2/3
range, versions 4.x and 5.x. Binary compatibility broken.

1.01 16/07/06 1 Financial Ledgers + Commercial Pack (Phase 2) non-beta release. Binary compatibility
broken.

1.02 11/08/06 1 Updated to provide support for V6 of the TAS BOOKS product range. Binary compatibility

broken due to introduction of Retail Pricing in Customer Prices.

2 Enhancements to SOP Invoicing (better financial date support) and Sales Order product
lines (cost price support)

1.03 10/11/06 1 Performance/speed improvements in terms of accessing master and transaction objects

23/11/06 2 Tolerance checking against TAS settings when adding VAT to a transaction; also support
for posting SOP Credit Notes & Credit Lines on Sales Invoices

29/11/06 3 Support for posting Sales Orders with Settlement discounts; also for Foreign Currency
Transactions in Financual Ledgers

1.04 20/02/07 1 Support for TB v6 SP1 (Db v6.11); Customer From/To filters added to Dynamic Discounts;
allow writing to Retail Price property in Products

06/03/07 2 Increased Financial Calendar range for retrospective Financial Journal postings up to 2
Years Past (from Current and 1 Year Past)
1.05 10/04/07 1 Support for TB v6 SP2 (Db v6.12) following introduction of revised HMRC rules for

Construction Industry Scheme (CIS) from 06/04/07;

10/05/07 2 New filters for Products and SalesOrderHeaders classes. Adding VAT Information to
financial journals must be within the VAT Tolerance Level or £0.01, which ever is greatest.

17/07/07 3 New 'AllocateSalesLedgerCredit', 'DisputePurchaseLedgerinvoice' &
'UnDisputePurchaselLedgerlnvoice' functions

1.08 19/02/08 1 Added compatibility with TAS BOOKS v7 SP1 (***Binary Compatibility broken***)

2 Posting a Sales Order now updates the correct COAs as setup in the WarehouseProduct
records in StockControlPlus

1.09 24/04/08 1 VAT only transactions now allowed (***Binary Compatibility broken***)
2 PQO's added; SO Payment Type added to FinancialJournalLine TransactionType enumerator
1.10 30/04/08 1 Posting Sales Orders to EC Customers now handled, including updates to the VAT

Transaction record.

1.1 06/05/08 1 Minor bug fixes and maintenance (***Binary Compatibility broken***)
1.12 22/05/08 1 Added Allocate Purchase Invoices (***Binary Compatibility broken***)
1.13 06/08/08 1 TB v8.17 compatible
1.14 11/08/08 1 Minor bug fixes
1.15 04/12/08 1 Minor updates
1.16 22/01/09 1 Small updates, including bug fix to CashBook_Receipt_ VATRefund &
CashBook_Payment_VATPayment (previously called CashBook_Payment_VAT_Refund)
transactions (***Binary Compatibility broken***)
1.17 13/02/09 1 Customers can be set up as Suppliers and vice-versa
20/03/09 2 Added extra filters to StockTransactionHeaders & FinancialJournalLines collections
30/03/09 3 Added new filters to StockTransactionHeaders.
1.18 04/06/09 1 Posting Sales Orders now optionally creates an OrderEvent record (***Binary Compatibility
broken***)
1.19 23/06/09 1 UniquelD added to Product (***Binary Compatibility broken***)

2 Date fields changed from long to date in FinancialJournallLine, StockTransactionHeader &
StockTransactionLine classes

3 NoSlipReference_PaymentReceipt added to allow posting of SLReceipt &
CashBookREceipt transactions without supplt

1.20 02/07/09 1 New filters added to POHeaders (***Binary Compatibility broken***)
2 New TASReader class for read only access

1.21 10/08/09 1 Fix to posting credit notes with service mounts. VAT Transaction now has correct signage.
(***Binary Compatibility broken***)

2.01 21/10/09 1 Compatible with TSB & TFB (***Binary Compatibility broken***)

2.04 07/01/10 1 Compatible with TSB & TFB SP1 (data v1.21)
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Version Date Item | Feature Add/Change Notes
2 Added the ability to use optionally the TAS Invoice numbering system in Stock Transactions
2.05 31/01/10 1 ***Binary Compatibility broken***
2.06 03/06/10 1 Added SIM API as separate deliverable within TASLink to allow developers to maintain TAS
integrations and access rights.
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